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About Poker Challenge

Poker Challenge is an exciting new game that combines the best elements and excitement of high
stakes poker, with the strategy of classic board and computer games like Yahtzee, Shanghai, and
Tetris.

As in poker, being successful at Poker Challenge involves an element of chance. But it will quickly
become apparent that much more than luck is required for winning play. Successful Poker Challenge

players must look at the cards with a keen eye, think strategically, and exercise patience in order to
build high scoring plays.

A Brief History of Poker

Related Topics
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QuickStart:

1. Click on cards that make valid poker hands

- cards must be adjacent (touching on either the top, left, right or bottom)
- you will not always select 5 cards (i.e. choose only 2 cards for a pair)
- straights do not have to be connected in sequence as long as they are adjacent

2. Click on the green tabletop to "play" your selected cards

3. Jokers are NOT wild

- jokers may be removed singly or along with any one adjacent card
- jokers on the bottom row are "FREE" and may be removed singly or with ANY card

4. The game is over when there are no valid moves remaining

- the computer will display a message if there are no moves left
- if you don't see a message and can't find a move go to the View menu and select Hint

Overview (The Basics)

A more detailed explanation of how to make plays. Applies to standard game and contests.

Standard Game
This topic will teach you all about the standard game. ("New Game")

Contests...
Click on this topic to learn about the Poker Challenge contests.

Related Topics
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The scoring in Poker Challenge follows the video poker standard.
associated with each hand type:

Scoring Table:

Pair........
2 Pairs.....
3 of a Kind.
Straight....
Flush.......
Full Houss..

4 of a Kind....
Straight Flush.
Royal Flush....

. $2.00
. £5.00
$10.00
$15.00
$20 .00
$25 .00
$50 .00
$75.00
$100 .00

Thus, the following dollar values are

Note: If you are looking for a quick scoring reminder during the game, you can click on any of the

"plays" boxes at the bottom of the game window.

Related Topics

Poker Challenge Scoring
Contents



Finding plays isn't as easy as it looks. Beginners have a tendency to go for the easy plays and thus
overlook higher scoring hands. They will click on a 3 of a kind, for example, and fail to see the
neighboring pair that would have given them a full house! This help topic will teach you how to find,
and build those high scoring plays!

Study the Cards

Don't play the first good hand you see -- study the cards before you make that first play and make sure
you aren't missing (and potentially messing up) a better play somewhere else.
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At left, see if you can find a 3 of a kind.

Did you find the 9's? Did you see all 4 of them? (A 4 of a kind is worth $50.00!)

Look for Possible Straight Flushes or Royal Flushes

These are the two highest scoring hands in poker, and you should begin each game by looking for
these plays. You will seldom find a natural (where the cards are all together after the deal) but it is
often possible to build these hands if you're willing to work for them.

Here's an example: look at the randomly generated layout below:



Notice the bottom row. The 5, 6, and 8 of hearts are right next to each other. Take a quick look for
other cards that could be used in a straight flush. The 4 and 7 of hearts are not too far away, but you
have 2 problems: First, you must get rid of the 3rd column -- that will squeeze the 4 and the 8 together
-- then you need to drop a joker to the bottom row so you can take out the Jack of hearts in the corner,

thus bringing the 7 of hearts into play.

Look carefully at the cards in the 3rd column. Do you see how to solve both problems? Play the 2
pairs, Kings and 8's; that will drop the 3 of diamonds next to the 3 of hearts. The cards will then look

like this:
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There is now a Joker on the bottom row that can be used to remove the Jack of hearts. But not yet!
Click on the Joker above the 3 of diamonds and drop the King down. You've just made a full house --
Kings and 3's -- worth $25.00!

Now you can take out the Jack of hearts with the single Joker in the 3rd column. You've just built a
straight flush and earned $75.00!



Tips and Strategies
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The Finding Plays topic includes some thoughts to help you build high scoring plays. Here are some
more things to consider:

Free Your Jokers

Try to drop your Jokers to the bottom row. They will be much more useful if they are "free" and this
could be the key to some big plays later in the game.

Don't Strand Cards

Try to remove cards from the columns and rows as evenly as you can. You will have many more play
possibilities if you can build horizontally and vertically, so try to keep the cards in "blocks."

If you find a short column between 2 taller columns, try to remove it. That will squeeze the taller
columns together and probably open up more plays.

Build Up Your Bonus

If you are sure you are going to get a bonus, try to build up the bonus hands -- even if it means
sacrificing a higher scoring play. For example, you are probably better off giving up a full house if it is
late in the game and you still need a 3 of a kind.

Lower the Card Count

The bonus is based, in large part, on how many cards you have left when you run out of moves. Try to
remove as many cards as possible, even if it means making some smaller plays.

Think Ahead

Sometimes, to make those high scoring plays, you will have to think several moves ahead. You may

be close to a 4 of a kind, for example, except you have one card in the way. To get rid of that card will
require a free Joker. To drop a Joker to the bottom row you will have to remove a flush, but you can't

make the flush until you play a pair... It can get complicated very quickly -- but that just makes it even
more satisfying when you finally figure out how to make a really tough play!

Related Topics

Finding Plays
Contents



The registration fee for Poker Challenge is only $15.00, and there are 3 simple and convenient ways for
you to pay:

Registering with a Check or Money Order
You can register by sending a check or money order directly to the author. (U.S. funds only.) You will
receive your registration code by e-mail or phone (your choice), usually within 24 hours.

Registering through CompuServe (SWREG)

If you are a member of CompuServe you can register online with the SWREG service. (The
registration ID is 14039.) You will receive your registration code by e-mail, usually within 24 to 48
hours.

Registering by Credit Card (MasterCard, Visa, Discover Card)

If you would like to charge your registration, you may do so by phone (toll free), by fax, through e-mail,
or over the Internet. You will receive your registration code at the time you register, or by e-mail,
usually within 24 hours.

Related Topics

Benefits of Registration

Removing the Game
Contents



The registration price for this program is only $15.00! Poker Challenge is shareware, and if you use it
for longer than the 21 day evaluation period, you are required by law to pay the nominal fee.
Supporting shareware development will result in higher quality programs, so please take the time to
register this product, if you enjoy it.

Registering the game will provide you with the following:

A registration code and instructions. Entering this code into the game will eliminate the registration
notices, enable you to play all the contests, and let you view the top scores and scorers! (The High
Score screen will only be visible during the 21 day evaluation period. After that, your scores will be
saved but you will not be able to view them.)

Free upgrades to all future versions of the product. If you provide a valid e-mail address you will be
notified of new versions and where to download them. Your registration code will work for any upgrade
version, so be sure not to lose it. (If you do lose it, you can contact the author for a new one.)

Technical support, via e-mail. (74151.1445@compuserve.com)

Visit the Poker Challenge Homepage for revisions and information:
http://ourworld/compuserve.com/homepages/john_c/Pokerchl.htm

Related Topics

Registering with a Check or Money Order
Registering through CompuServe (SWREG)
Registering by Credit Card

Removing the Game

How to Register
Contents



Welcome to Poker Challenge. The following topics should help you get into the game quickly and
without confusion.

Players:
Player List... (Players Menu)
Add New Player (Players Menu)

Delete a Player (Players Menu)

Game:

Choosing a Game
New Game (Game Menu)

Contests... (Game Menu

Game Options:
Current Game Stats (View Menu)
Hint (View Menu)
High Scores (View Menu)

Undo Last Move (Options Menu)
Refresh Screen (Options Menu)
Preferences (Options Menu)

Related Topics

Overview (The Basics)

How to Play
Contents



Most historians trace the evolution of the game we call poker to a book published in England in 1674.
Cotton's Complete Gamester's described how to play Post and Pair. This unique little card game
seems to have been the inspiration for Bragg, which in turn inspired the poker we play today.

Until 1850, there were no printed rules for poker. Neither of the two American Hoyles then in print
mentioned it at all. In fact, the expression "poker according to Hoyle" is a bit of a misnomer because the
English writer and lawyer Edmund Hoyle (1672-1769) never even heard of poker: he died sixty years

before the game originated!

Many people are surprised to learn that the straight and straight flush, didn't become valid poker hands
until after the Civil War. They were described in an 1867 edition of Hoyles, along with the first
recorded mention of the word "ante" and an explanation of how jokers could be used as wildcards.

The first printed poker rules seem to have been written by General Robert E. Schenck, the United
States minister to England. While staying at an elegant country house in Somersetshire he introduced
the game to the other guests. The hostess, a prominent duchess, was so taken with it she persuaded
him to write down the rules. In 1872, the duchess privately printed the rules for her court, and the game
caught the fancy of Queen Victoria. After that, the popularity of "Schenck poker" spread through Great

Britain.

After 1875, books about poker appeared regularly in America, England, and Continental Europe.

1. Debebian, D., Game of Poker, New York, 1889.
2. Habeythe, Jeu de Poker, Paris, 1886
3. Coffin, G. S., Poker Game Complete, Faber and Faber, 1950.

Related Topics

Introduction
Contents



When you first start the game you will probably want to add a new player. Wait until the Player List
window appears and then click on the Add New Player button. Now type in a name for the new player,
making sure it does not have more than 21 characters. (If you change your mind about adding a new
player, click on the Cancel button.)

Poker Challenge will only keep track of 12 players, so if you click on the Add New Player button and
there isn't room left, you will be prompted to delete one of the current players.

Note: You can add a new player during a game by pulling down the Players menu and selecting Add
New Player.

Related Topics

Deleting a Player
Contents



To permanently delete a player from the game, click on the Delete a Player... button in the Player List
Window. You will then be prompted to choose a player, and the player names will turn yellow.

Click on the name of the player you would like to delete. A dialog box will appear with the message:
"Are you sure you want to permanently remove [Name of Selected Player] from the game?"

Click Yes to permanently delete the selected player
Click No if you would like to delete a different player
Click Cancel to return to the player list without making any changes

If you do not wish to delete a player, click on the Cancel button at the bottom of the list of players.

To delete a player during the game, pull down the Players menu and select Delete a Player...

Related Topics

Getting Started

Add New Player
Contents



The Player List window appears at the start of every game, and shows the name of each active player,
sorted by the size of their bankroll. (The player with the most money is listed first, and whoever has
the least money -- or the largest debt -- will show up at the bottom of the list.)

This window can be displayed during the game (to change players, for example) by selecting Player
List... from the Players menu.

Related Topics

Getting Started
Add New Player

Delete a Player...
Contents



After you have selected a player, the green tabletop will appear. If you pull down the Game menu you
will see the following two game options:

New Game

Click on poker hands in an 8 x 7 grid and try to build the highest possible score! Entry fee: $112.00 will be deducted
from your bankroll each time you start a new game.

Contests...

Contests are an excellent way to build up your bankroll -- but to win the prize you must play every single card!  Entry fee:
none.

Related Topics

Getting Started
Contents



This is the standard game. Fifty six (56) cards are dealt onto the table, face up, in 8 columns of 7
cards each.

The game is over when all the cards are removed, or when there are no more valid plays. (A message
will appear if you are out of plays.) If your score is greater than the entry fee of $112.00, you win! If it
is less, however, your game score goes to $0.00, and you lose it all!

"Play" Lights

At the bottom of the screen you will see small boxes with each type of "play” that can be made in the
game. These boxes will light up each time you have one or more plays of that type. It is important to
keep track of your plays because it affects the size of your bonus, should you earn one.

You may also click on these boxes for a description of the play and scoring information.

Scoring

The entry fee for this game is $112.00 ($2.00 per card), so this amount of money is subtracted from
your bankroll every time you start a new game.

Each time you remove cards from the table by making plays, your score increases. (See the Scoring
topic for play values, or click on the play lights at the bottom of the game window.)

Once your score is greater than $112.00 you will hear a cash register sound and your score will change
color from red to green. This signals that you have won! After the game is over the Poker Challenge
Scoreboard will appear to tally the final results.

Earning a Bonus

You will earn a bonus if your net score (the game score minus the entry fee, minus $2.00 for every card
remaining on the table) is greater than $0.00. The size of the bonus is determined by multiplying your
net score by the number of different "plays" you made. Again, the play lights at the bottom of the game
screen will help you keep track of your possible bonus.

EXAMPLE:

Let's say that the game ends and your score is $150.00. We'll also assume that there are 10 cards left
on the table, and that you used 5 different plays during the game: pair, 2 pairs, full house, flush, and
straight.

Game Score: $150.00
- Entry Fee: $112.00
- Cards Left (x $2.00): $ 20.00
= NET SCORE: $ 18.00
Net Score: $ 18.00
x Plays: 5
= BONUS: $ 90.00
Bonus: $ 90.00
+ Game Score: $150.00

= FINAL SCORE: $240.00



Related Topics

How To Play
Finding Plays
Scoring

Tips and Strategies
Contents



Contests are an excellent way to increase the size of your bankroll. To earn the cash prize, however,
you must figure out how to remove every single card from the table!

You may re-play contests you have already completed, though if you do this you will NOT be eligible for
the cash prize -- this is only awarded once for each player.

Selecting a Contest

To select a contest, simply double click on a contest in the list, or highlight the contest by clicking it
once, and then clicking on the OK button at the bottom of the window.

Click on the up or down arrow on the scroll bar to the right of the contest list to scroll the list up or down.
Alternately, you can use your cursor keys to move the highlight up or down. (The list will scroll down if
you attempt to move the highlight off the top of the list, and up if you attempt to move if off the bottom of
the list.)

Note that every time you highlight a name on the list, a description and icon appear. These will give
you a little more information about that contest.

In addition to the contest name, the list also shows the relative difficulty of each contest, and the prize

money. The difficulty level gives you a rough idea how hard the contest will be to solve, while the prize
is the amount of money you will win after you complete the contest successfully.

Related Topics

Getting Started

How to Play
Contents



It feels a little pretentious to write such a long list of acknowledgments for a simple card game, but what
the hell...

Dedication

Poker Challenge is dedicated to my mother, whom Dad and | affectionately call "Madame Shanghai."
The name came about after she grew addicted to Activision's similarly monikered tile matching game.
We, her family, colluded and had an "Intervention” for her, but within weeks she was back at it. SA
(Shanghai Anonymous) also proved ineffective. Hopefully, she will find Poker Challenge to be equally
addictive and we will gradually be able to wean her off that other devilish game.

Support (Emotional)

I'd like to thank my wife, Melanie, and my daughter, Autumn, for being so patient during the creation of
this game. They are the best things in my life.

Support (Technical)

Poker Challenge would not have been possible without Stephen Murphy's excellent freeware "qcard.dll
The card back designs included in gcard.dll were created by Daniel Di Bacco. | thank them both.

This Help file was written with the aid of a tool called VB AHA!!! by Craig Villalon. His efforts are
appreciated.

The SETUP.EXE file was created using a handy shareware program called Insteasy by Kurt P. Herzog.
Much obliged, Kurt.

Poker Challenge was written in Visual Basic (version 3.0), a Microsoft Corp. product.

Testing

The game was tested by a number of people, including: Melba Cutter (Madame Shanghai), Melanie
Cutter, Jack Cutter, Randy Rasa, Tim Royal, Pat Cook, Stephanie Berg, Wayland Wasserman, Jeff
Rollosson Halbhuber, D.M. "Djaxn" Clayton, David Grady, Allen McPheeters, Paul Reckamp, Mark
Swardstrom, Peter Heinrich, and Matt Mansell.

Special Thanks

| owe a special thanks to Tom Warfield, the author of Pretty Good Solitaire. (Don't believe the title, his
solitaire collection is fantastic.) Tom suggested the "qcard.dll" file, provided some technical help, and
answered countless questions. All this to help someone who hoped to provide him with a little
competition. Hopefully, | will be able to return the favor someday.

I would also like to single out Randy Rasa, a shareware card game pioneer. He not only helped Beta
test the game, he gave me some excellent advice and lots of encouragement.

Related Topics

Miscellany
Contents



Both the Contests and the standard game (Poker Challenge) are played in accordance with a basic set
of rules:

Making Plays

The primary activity in Poker Challenge is to click on and "play" valid poker hands. To do this, click on
the appropriate cards, then on the green tabletop to complete your play. The cards you select must be
adjacent, touching at least one other card on the top, left, right, or bottom. (Each time you click on a
card, it will be marked with the word "Play”. Click on the card again to deselect it.)

Any cards above the cards removed will drop down to fill in the holes. If all the cards in a column are
removed, the columns to the right shift left to close the gap.

Valid Poker Hands

Every standard poker hand is represented. However, unlike regular poker,
plays do NOT always consist of 5 cards:

Pair Two adjacent cards of the same value

2 Pairs Two cards of 1 value & 2 of another value
3 of a Kind Three adjacent cards of the same value
Straight Five adjacent cards in a series

Flush Five adjacent cards of the same suit

Full House One pair and one 3 of a kind

4 of a Kind Four adjacent cards of the same value
Straight Flush Five same suit cards in a series

Royal Flush A, K, Q, J and 10 of the same suit

@
NOTE: The order of the cards is not important, provided they are adjacent. The player at left is
getting ready to play a straight. (Notice the "play" icons on the selected cards.) In this example, even
though the cards are not in a specific order, the 5 cards are in a series, 1-5, and they are adjacent to at
least one other card on the left, right, top or bottom.

Actually, this player might also have chosen the 3 of hearts, 5 of clubs, 6 of spades, 4 of hearts, and 7
of hearts. Oreventhe 4,5, 8,6,and 7.

How to Use the Jokers

The jokers are NOT wild, and thus cannot be used to build any of the plays displayed above. They can
only be removed singly, or with any one adjacent card. See the Tips and Strategies topic for
information on how to strategically use the jokers to make big plays.

"Free" Jokers

Jokers on the bottom row are considered "free" and may be removed along with ANY other card on the
table. (It does NOT have to be adjacent to the joker.) Free jokers may also be removed singly.

Ending the Game

The game is over when there are no plays left on the table. When this happens, a message will
appear informing you of the game status. If you do NOT see this message the game isn't over and
you should look for another play. If you need help, pull down the View menu and choose Hint for a
clue about the remaining play(s).



Related Topics

How to Play
Scoring
Finding Plays

Tips and Strategies
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Pair: 2 cards of the same value.



2 Pairs: 2 cards of one value and 2 cards of a different value.



3 of aKind: 3 cards that have the same value.



Straight: 5 cards in a sequence, but not from the same suit.



Full House: 2 cards of the same value, along with 3 cards of a different value.



Straight Flush: 5 cards of the same suit, that are also in sequence.



Royal Flush: the Ace, Jack, King, Queen and Ten -- all of the same suit.



4 of a Kind: 4 cards of the same value.



Flush: 5 cards of the same suit.



Poker Challenge Registration Form

To print this form, pull down the help file "File" menu and select "Print Topic"

Name

Address

City State/Province
ZipCode/PostalCode Country

E-Mail Address

To receive your registration code by phone, include your number below:

Telephone Number (Optional)

What did you think of the game

Send payment of $15.00 to:
John Cutter
23734 N.E. 24th PI.
Redmond, WA 98053

Please make checks payable to: John Cutter

Checks or money orders will be accepted. Checks must be drawn on a U.S. bank. The registration
code will be sent as soon as payment arrives.



The Current Game Stats window can be displayed at any time during the regular game, or the
Contests. You will find the following information and options:

Game:

Cards Remaining:
Hands:

You Need:

Prize:

Related Topics

This is your score for the current game.

The number of cards left on the table.

The number of different hand types played.
The amount of money you need to win the game.

The size of the prize for the current contest.

Getting Started
Contents



Sometimes, beginners have trouble finding valid plays. The message indicating the game is over
hasn't appeared, but they just can't see any more moves!

The Hint command (pull down the View menu) will help you find valid plays. It won't cost you anything
to get a hint, but the hints are a little cryptic so you'll have to earn any help you receive.

Related Topics

Getting Started

Finding Plays
Contents



The High Scores screen shows the top 10 Poker Challenge scores. Contests do not have a score, so
this only applies to the regular game.

To reset the scores, click on the Reset Scores button. NOTE: This is a permanent change -- the
scores will be deleted -- so you will be prompted: "Are you sure you want to reset the list of High
Scores?" Click No or Cancel if you change your mind.

NOTE TO NON-REGISTERED GAMERS: The High Scores screen is only available during the 21 day

evaluation period. After that your high scores will be saved, but you will not be able to see them.
(Must be a bug!)

The current Poker Challenge single game record is an astounding: $1440.00! (Recorded December
19, 1996 by Jack Cutter.)

Related Topics

Getting Started
Contents



This option will undo the last move and is useful in case you made a mistake or wish to try a different
play. Note that only the /ast valid move can be undone; after you use this command it will become
unavailable until you make another move.

Convenience Feature

If you have a 2 or 3 button mouse, you can right click on the green tabletop to invoke the Undo Last
Move feature.

Related Topics

Getting Started
Contents



On rare occasions conflicts between applications or windows may cause garbage to appear on the
screen. |If this ever happens, pull down the Options menu and select the Refresh Screen option. This
should clear up the problem.

Related Topics

Getting Started
Contents



The Poker Challenge Toolbar is off by default, but you can turn it on by going to the Options menu and
selecting Preferences, then Toolbar. For more information on the toolbar, click on the Toolbar link,
below.

Toolbar

The Preferences option will also let you toggle the game sounds on or off. Simply click on Options,
Preferences, then select Sound Effects.

NOTE: If you see a checkmark next to the option, it means itis "on" Select it again to turn it "off"

Related Topics

Getting Started
Contents



The Poker Challenge Toolbar is simply a different, and for some a more convenient way to reach some
of the game options.

i (3 ) (il (2] [

Click on the buttons for more information.

Related Topics

Preferences (Options Menu)

Getting Started
Contents



Help
Clicking on this button will display the Poker Challenge help file.



Player List
Click on this button to display the Player List window.



High Scores
Click on this button to see the High Scores screen.



Current Game Stats
Click here to see information about the current game.



Undo Last Move
Click this button to "undo" the previous move.



Restart
Clicking on this button will restart the current game or contest. (You do not have to pay an entry fee
again for restarting a game.)



Hint
This button will display a hint.  (If you can't find any valid plays.)



Recommended Shareware
Some other fine card games you should check out!

Comments about Poker Challenge

What others are saying about the game

Designer Notes

Just me rambling...

Euture Versions
Ideas for future versions (updates are free to registered users)

Revision History

Chronological evolution of Poker Challenge

Legal and Vendor Info

Vendor Information, Warranty, Licenses

Acknowledgments

Special thanks for special folks

Related Topics
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Although Poker Challenge has been thoroughly tested on a variety of machines, the vast array of
Windows hardware and software available today makes it nearly impossible to find every problem. If
you're having difficulties with the game, please let me know about it and I'll do my best to help.
Describe the problem in as much detail as you can, and include information about your computer's
configuration. | can be reached at:

74151.1445@compuserve.com

Or you can send a letter to:
John Cutter
23734 NE 24th Place
Redmond, WA 98053

Visit the Poker Challenge Homepage for the latest revisions and information:
http://ourworld.compuserve.com/homepages/john_c/Pokerchl.htm

Known Problems

As of this writing, the only known problem with the game is related to the use of Large Fonts. Thisis a
fairly uncommon Windows configuration that will cause display problems on some Poker Challenge
screens. | recommend using Small Fonts for best results.

Also, though not a bug, Poker Challenge uses the entire screen display at resolutions less than 800 x
600, meaning the Windows 95 taskbar will NOT be visible. At lower resolutions there just isn't enough
room for the game when the taskbar is showing. Sorry for the inconvenience. (This problem could
be fixed in future versions of the game.)

Related Topics

Miscellany
Contents



The title screen appears before each game. Click the Play button when you are ready to begin.

Registered users may turn off the title screen by clicking on the "Title Screen" selection under the
Options/Preferences menu.

Related Topics

How to Register
Preferences

Contents



There are many excellent shareware games available for DOS, Windows 3.1 and Windows 95. Here
is a list of some favorites!

Shareware by Randy Rasa

Randy Rasa is a pioneer in the field of shareware card games. You can download his products from a
variety of sources, including his website, which also includes links to other sites with card games.
Check it out at: http://www.sky.net/~rrasa/sw.html

Randy Rasa's Shareware Collection

Pretty Good Solitaire 2.1 (by Tom Warfield)

A collection of 60 Windows solitaire games, with undo/redo, autoplay, win/loss statistics, selectable card
backs and background color. Games are saved automatically upon exit. A full-featured solitaire
collection for the serious player. Shareware, $19.

Pretty Good Solitaire and other games by Tom Warfield may be downloaded from his web site at:
http:// www.goodsol.com

Rummy 500 (by MeggieSoft Games)

This Gin Rummy variation is extremely well done and includes an incredible wealth of options and
features. This company also has a terrific Gin Rummy game available. You can download both titles
from CompuServe (GO WINFUN), as well as a variety of other shareware game sites on the Internet.

Related Topics

Miscellany
Contents



At the time of this writing, Randy Rasa's other shareware card games include:

Poker Squares

A solitaire card game for Windows, also known as "Poker Solitaire," where the object is to make the
best possible poker hands on a 5x5 grid. Challenging and addictive, no two games are ever the same!
Complete with sound. music, full statistics. Very slick interface.

Get it at ... http://www.sky.net/~rrasa/sw_psq.html

Chinese Solitaire

Chinese Solitaire for Windows, Version 1.01. This is a brand new game combining the best elements of
Klondike and Scorpion, with a distinctly Oriental flair. Feature-packed solitaire, with full statistics, easy
mode, autoplay, selectable card backs and colors, great graphics, and excellent sound.

Get it at ... http://www.sky.net/~rrasa/sw_cs.html

Four Seasons

A solitaire card game for Windows, also known as "Corner Card" and "Vanishing Cross". Thisis a
very full-featured game, with multimedia sound, undo, a high-score list, and challenge scoring.

Get it at ... http://www.sky.net/~rrasa/sw_fs.html.

Solitaire Suite

This is a collection of seven classic solitaires, including Calculation, Concentration, Idiot's Delight,
Midnight Oil, Monte Carlo, Osmosis, and Royal Cotillion. Feature-packed and easy to play, this is a
very popular collection. Requires EGA or VGA and a mouse.

Get it at ... http://www.sky.net/~rrasa/sw_ss.html

Simple Pleasures

This is a collection of eight new solitaires, all in a smooth and elegant program. All of the best features
of Solitaire Suite, plus a few more. A new favorite! Requires EGA or VGA and a mouse.

Get it at ... http://www.sky.net/~rrasa/sw_sp.html

Pyramid Deluxe

This is a SuperVGA version of the classic solitaire card game, featuring 640x480x256 graphics, hint
mode, undo, demo mode, and full scoring statistics for up to ten players. Requires 386, SuperVGA
and a mouse.

Get it at ... http://www.sky.net/~rrasa/sw_pd.html

FoxFire 13 for DOS

This is a new, original solitaire conceived by Todd Svec, and written by Randy Rasa. It is one of the
first DOS solitaires to feature SoundBlaster sound, and offers all the features you've come to expect
from my games, including multi-player support, undo, and color configurability. Requires EGA or VGA
and a mouse.

Get it at ... http://www.sky.net/~rrasa/sw_ff.html

Todd Svec handles FoxFire 13 registrations -- download the game and print out the registration form for
details...

FoxFire 13 for Windows

This is a Windows version of FoxFire 13 for DOS, and shares the original's great gameplay, and offers
excellent sound support to complement a full range of features. Addictive!

Get it at ... http://www.sky.net/~rrasa/sw_ff.html

Todd Svec handles FoxFire 13 registrations -- download the game and print out the registration form for
details...
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The response to Poker Challenge has been a bit staggering. Here are some comments by players
and reviewers:

"This game rocks! Poker Challenge successfully manages to eclipse Tetris for addicting game quality.
This is a game that is going to stay on my hard drive forever. | even erased Solitaire!"

Tim Royal (GameNet)
(GameNet awarded Poker Challenge its 1996 "Puzzle Game of the Year!")

"Totally addictive! | can't stop playing..."
J.D.C. from Colorado

"All in all | think this is one of the most entertaining solitaire games I've ever seen. You've got a great
program here!”

D.M.C from Utah

"This is one fine, and surprisingly addictive, game!"
R.R. from Kansas

"Can you please send me the latest version of Poker Challenge? If | come home empty handed my
wife will make me sleep on the couch tonight."”

W.W. from Washington

"It really is a fun game! | have already spent a lot of time with it. Very addictive. (Really like the sounds
and graphics.) Great job!"
S.M from Alabama

"Now that | am hooked, my food bill has gone down, | never turn on my TV, and | cancelled my
subscription to Mad magazine and People. Thanks again!!!!"

M.M. from California

"This game is really well done!"
P.R. from Wyoming

"Great game! | get so frustrated that | have to keep playing until | can beat it!"
M.A. from Washington

"I really like the way you did the Contests. They are balanced perfectly!"
P.C. from Oregon

"This is the kind of game that really makes you think. There is some luck involved, but a lot of strategy,

too. Nice job!"
B.A. from Wyoming
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| have been a professional game designer for nearly 14 years. | created my first game in the
basement of my parent's home on a Timex Sinclair 1000 that had a whopping 16K of memory, and a
cassette tape for a disk drive. (It took almost 20 minutes for the game to load.) Since that "slow" start
I've designed or produced close to 50 commercial games.

You might be wondering why | decided to write a shareware game. Well, there were actually three
reasons. First, | wanted to create a game my parents could play and enjoy. (Poker Challenge is
dedicated to my mom.) Most of my titles have been targeted at "hardcore” gamers, and thus have
never really appealed to my mother and father, who favor card and board type games.

Second, | wanted to test the shareware concept. It seems like such an ideal way to release great
games that are also inexpensive. That's a win/win situation for authors and gamers both!
Unfortunately, if customers don't register their favorite games, there won't be much of a future for it.
Time will tell, I guess. (I'm hoping for the best here, because | would enjoy writing another shareware
gamel)

Finally, | created Poker Challenge because | wanted to get back to my roots. Back to the cool
basement in my parent's house where my friends and | would sit for hours on hot summer days, playing
the latest Atari cartridge or working on grand new game ideas. Things are a lot different now. Today's
games require large teams of specialists: engineers, artists, animators, musicians, writers; and while
the team aspect is exciting and rewarding, it's impossible to feel creative ownership for a game that has
resulted from the combined efforts of so many different people. Would Poker Challenge be better if I'd
had an Art Director and a team of engineers? Possibly. Would | have had as much fun? Not a
chance!
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| have several ideas for future versions of Poker Challenge. (Registered users will be notified of these
future versions, and will be upgraded for free!) If you have any suggestions or ideas, please don't
hesitate to let me know!

New Contests

The next release of Poker Challenge will probably include some new contests. I'll concentrate on
"puzzle-oriented" contests like "A Girl's Best Friend", rather than having large blocks of cards to work
through.

Two Player Mode

It wouldn't be too hard to add a Two Player Mode. Each player has X seconds to find a play, then at
the end of the game the player with the highest score is the winner!

Rule Variations

It might make clearing all the cards too easy, but I'd like to experiment with a variation where straights,
flushes, and straight flushes aren't limited to just 5 cards. In other words, as long as all the cards are
adjacent, you could build a straight from Ace to King. Additional cards would be worth $3.00 each for a
straight, $4.00 each for a flush, and $25.00 each for a straight flush.

Tim Royal (GameNet) suggested a canasta variation.
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October 3, 1996 - released version .80

First test release to limited testing audience. Basic game with no sound effects and very few features.
No logic to test for "end of game" condition (no more moves).

November 20, 1996 - released version .90
Added sound and put in code to check for "valid moves." Created 10 contests.

December 3, 1996 - release 1.0
Implemented High Scores and Title Screen (with animations), created first draft of help file, built a
Setup.exe file. Distributed this version to full test audience.

December 15, 1996 - release 1.1

Included shareware registration features, tweaked sounds and gameplay. Added remaining contests,
and combined them all into one file. Fixed lots of mostly minor bugs.

January 4, 1997 - release 1.2

Removed unnecessary code and files. Added bonus for clearing all cards (normal game). Fixed very
elusive crash bug (overflow error). Finalized sound effects and text. Finalized help file. Added
licensing and vendor information.

January 8, 1997 - release 1.3
Fixed a crash when all cards removed in standard game, and another following the "Thomas Crapper"
contest. No other substantive changes.

January 11, 1997 - OFFICIAL PUBLIC RELEASE OF VERSION 1.3!

January 25, 1997 - release 1.4

Fixed a fatal error caused by the way Windows handles currency values outside the United States.
Players in some countries get a "Type Mismatch" error after winning the game, and when attempting to
access the High Score screen. No other changes were made to this version.
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Registering through CompuServe is quick and easy; the $15.00 fee will simply be added to your bill at
the end of the month. For complete instructions follow the simple steps below: (These instructions
are for WinCim 2.0.1 -- your version may vary.)

Pull down the Services menu and select "Go"

Type "SWREG" at the "Service" prompt

When the service appears, double click on "Register Shareware"
Read and accept the legal notice

Choose your geographical region

At the Search Criteria menu double click on "Registration ID"

Enter the ID number: 14039

At the Search Criteria menu double click on "Display Selected Titles"
. Double click on "Poker Challenge"

10. When the description window appears click on the "Register" button
11. Enter your name, address and other information.

©COoNOOAMWNE

NOTE: Even though you select a disk size and a "Number of copies" you will not receive a disk.
Instead, you will be sent a CompuServe e-mail with your registration code -- usually within 24 to
48 hours. (Not having to send out disks helps us keep our costs down, and this savings is
passed on to YOU.)
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Fill out the registration form (click on the topic below) and send it along with a check or money order for
$15.00 to: (U.S. currency only)

John Cutter
23734 NE 24th Place
Redmond, WA 98053

Registration Form
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For your convenience, | have contracted NorthStar Solutions to process any orders you may wish to
place with your Visa, MasterCard, or Discover card. NorthStar Solutions can be easily contacted FOR
ORDERS ONLY via any of the following methods:

Phone Orders (Toll Free):

Calls are taken 10 am - 8 pm EST, Monday thru Saturday.
(Sometimes the lines get busy. If you can't get through, keep trying.)
1-800-699-6395 (Calls from the U.S. only)

1-803-699-6395 (Toll Free, U.S. and International)

FAX Orders:

Available 24 hours. International and business orders encouraged.
1-803-699-5465

Internet Orders:
Fill out the online order form at: http://ourworld.compuserve.com/homepages/starmail

E-mail Orders:

You can e-mail your credit card information to:
America Online: STARMAIL

CompuServe: 71561,2751

Internet: 71561.2751@compuserve.com

Please be prepared to provide the following information when ordering:
* The name and ID number of the program: "Poker Challenge" (#1118)
* Your mailing address
* Your Visa, MasterCard, or Discover card # and its expiration date
* Your e-mail address

IMPORTANT: NorthStar processes registrations ONLY, please contact John Cutter for any
product/technical support at: 74151.1445@compuserve.com.
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When you register Poker Challenge you will receive a registration code. To enter it, pull down the
Register menu and choose "Enter Code..." Type your code in the text box and press Enter or click the
OK button.

The registration code does NOT have spaces, and consists of 3 letters, a dash, a number, another
dash, and then 3 more numbers. For example: XYZ-9-123

If you are having trouble entering the code, contact John Cultter at:

74151.1445@compuserve.com
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You may remove Poker Challenge from your computer by simply erasing the files in the game directory,
and removing the group from the Program Manager or Windows 95 Start menu.

If you ran the setup program to install Poker Challenge ("setup.exe") the application name

"Pokerchl.exe" was registered in your Win.ini file, but no other files on your computer were modified.
Plus, ALL game files were copied to the game directory.
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Vendor Info

Poker Challenge may be distributed via BBSs, online services, the Internet (FTP, WWW), friends and users groups as long as all
files are present and unmodified. It may be not be sold on diskette or CD-ROM, either alone or as part of a collection, without
the permission of the author (with the exception of magazine cover CD-ROM that are sold with the magazine).  Diskette and
CD-ROM vendors should direct inquiries to:

John Cultter
23734 NE 24th PI.
Redmond, WA 98053

74151.1445@compuserve.com

You can also visit the Poker Challenge Homepage for the latest revisions and information:
http://ourworld/compuserve.com/homepages/john_c/Pokerchl.htm

RACKWARE VENDORS, CD-ROM PUBLISHERS AND RESELLERS, AND MAGAZINE EDITORS

Authorization to distribute Poker Challenge on a CD-ROM or in a retail setting will be handled on a case by case basis.
Publishers and distributors MUST contact the author for authorization before including this game on a CD-ROM or selling it in a
retail setting. However, magazines wishing to place Poker Challenge on a CD-ROM that is sold only with the magazine may do
so without specific permission, although contacting the author to get the latest version is encouraged.

Warranty

This software is sold "as is", without any warranty as to performance or any other warranties whether expressed or implied.
Because of the vast number of possible hardware and software environments in which this software may be used, no warranty of
fitness for a particular purpose is offered. The user assumes the entire risk of using this program. Any liability of the author will
be limited to product replacement or the refund of the registration fee.

License for Use and Distribution (Trial Use License)

Poker Challenge is NOTa public domain program. It is copyrighted by John Cutter. This software and accompanying
documentation are protected by United States copyright law and also by international treaty provisions.

You are granted a limited license to use this software for evaluation purposes for a period not to exceed 21 days. If you continue
using this software after the 21 day evaluation period, you MUST register it.

You may not use, copy, rent, lease, sell, modify, decompile, disassemble, otherwise reverse engineer, or transfer the licensed
program except as provided in this agreement. Any such unauthorized use shall result in immediate and automatic termination
of this license. All rights

not expressly granted here are reserved to John Cultter.

Limited Distribution License

SysOps: This program may be freely distributed over any on-line service systems as long as there are no files added to or
removed from the original compressed file package (with the exception of BBS "ad" files, which are permissible). Any and all
file modifications are strictly prohibited.

Disk Vendors, CD-ROM Vendors, BBS Sysops, Distributors, Computer Clubs and User Groups wishing to add this software
product to their library may do so in accordance with the Distribution Restrictions listed below.

Limited Distribution License: As the exclusive copyright holder for this software, John Cutter authorizes distribution only in
accordance with the following restrictions:

- This software must be distributed complete and unmodified. If any of the files specified in VENDORS.TXT are missing, please
contact the author for a complete product.

- Vendors choosing to distribute this software must send a copy of your catalog or product containing this program to the author.

- This software product - including all related program files and documentation files - CANNOT be modified in any way and must
be distributed as a complete product, without exception.

- Small additions to the product, such as the introductory or installation batch files used by many shareware disk vendors, are
acceptable, provided they do not interfere with any installation routine which may have been included by the author.

- No price or other compensation may be charged for this software product. A distribution fee of no more than US $5.00 may be



charged to cover production and handling costs.

- You may not list this product in advertisements, catalogs, or other literature which describes Poker Challenge as "FREE
SOFTWARE". Shareware is "Try-Before-You-Buy" software. Itis not free. You may not list Poker Challenge in
advertisements, catalogs, or other literature which describe it as "PUBLIC DOMAIN SOFTWARE". This is copyrighted material.
It is not, and never has been, in the public domain.
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